
레퍼런스 관리하기

레퍼런스 추가

RefWorks에 추가할 레퍼런스 찾기
RefWorks에에 추가할추가할 레퍼런스레퍼런스 검색하기검색하기:

다음의 경우, RefWorks에 레퍼런스를 추가할 수 있습니다:

• 레퍼런스가 있는 파일(PDF, Word 문서, 동영상 등)을 가지고 있는 경우, 그 파일을 RefWorks로 업로드 할 수 있습니다
(파일 업로드를 통해 레퍼런스 추가참조).

• 내보내기(지원되는 경우) 또는 Save to RefWorks 기능을 이용하여 웹 사이트에서 직접 레퍼런스를 RefWorks에 추가합
니다. RefWorks에저장을 참조하십시오.

• RefWorks 내에서 레퍼런스에 대해 외부 데이터베이스를 검색할 수 있습니다. 아래를 참조하십시오.

• 다른 사용자가 나에게 공유해 준 폴더로부터 레퍼런스를 추가할 수 있습니다. 아래의공유된 폴더의 레퍼런스활용을 참
조하십시오.

• 기관에서 설정한 경우, RefWorks에서 소속기관 도서관 사이트의 자료를 검색할 수 있습니다. 도서관 자료 목록에서
RefWorks에 추가할 레퍼런스를 찾았다면 해당 페이지에서내내보내기보내기 > RefWorks로 저장하거나, 레퍼런스를 다운로드
한 후 RefWorks로 업로드하십시오. 도서관 자료를 추가하려면추가추가 >새로운새로운레퍼런스레퍼런스직접직접입력입력을 선택한 후 오른쪽
사이드바에서링크리졸버링크리졸버(Find it @Library 등)를를사용하여사용하여원문원문(Full-text)검색검색을 선택하십시오 (기관마다 링크리졸버
이름이 다를 수 있음).

RefWorks에서에서 외부외부 데이터베이스데이터베이스 검색하기검색하기:

1. 왼쪽 사이드바에서데이터베이스데이터베이스검색검색을 선택하십시오. 주요 네비게이션 영역이 검색창으로 대체됩니다.

데이터베이스 검색

2. 데이터베이스를 선택하십시오. 이 필드는 자동완성 기능을 지원합니다.

3. 전체 필드에서 검색하려면 기본 검색을 이용하고 특정 필드에서 검색하려면고급검색고급검색을 선택하십시오.

4. 원하는 검색 결과 선택 시, 오른쪽 사이드바에서 해당 레퍼런스에 대한 상세정보를 볼 수 있습니다. 검색 결과를 레퍼런
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스로 추가하려면 원하는 레코드를 체크박스로 선택한 후가져오기가져오기를 선택하십시오. 프로젝트가 여러 개 있다면 레퍼런
스가 반입될 프로젝트를 선택하십시오. 레퍼런스는 최근 반입된 레퍼런스 탭에 추가됩니다. 선택한 레퍼런스를 특정
폴더에 추가하려면 폴더 메뉴에서 폴더 이름을 선택하십시오.

새로운 레퍼런스 직접입력하기
새로운새로운 레퍼런스레퍼런스 직접직접 입력하기입력하기:

1. 추가추가 >새로운새로운레퍼런스레퍼런스직접직접입력입력을 선택하십시오. 오른쪽 사이드바가 나타납니다.

오른쪽 사이드바

2. 레퍼런스 유형을 선택하십시오. 오른쪽 사이드바에 있는 나머지 필드들은 선택한 레퍼런스 유형에 따라 달라집니다.첨부첨부
파일파일, 태그태그 및및 제목제목필드는 항상 사용할 수 있습니다.

3. 제목에는 가능한 많은 단어를 입력하십시오. 필요 시제목제목필드에서

버튼을 클릭하면 도서관에 입력한 제목과 일치하는 자료가 있는지를 확인할 수 있습니다. DOI 필드에 값을 입력 한 후에도
이 버튼을 사용할 수 있습니다. DOI 필드는 대부분의 참조 유형에서 나타납니다(이 필드를 보려면더더많은많은데이터데이터항목항목추가추가
를 선택하십시오). RefWorks는 오른쪽 사이드바 하단에 검색 결과를 표시합니다. 원하는 레코드를 선택하면 RefWorks가 제
목을 완성하고 도서관에서 매치한 정보로 여러 필드를 채웁니다.

4. 레퍼런스 파일을 내 컴퓨터에 가지고 있거나 다른 관련 있는 정보를 파일로 가지고 있는 경우, 해당 파일을 마우스로 중앙
창에 끌어다 놓거나추가추가 > 파일파일업로드업로드를 선택하여 파일을 업로드하십시오. 지원되는 파일 형식은 Microsoft Word, Open
Office 및 PDF입니다.

5. 필요 시, 레퍼런스에 대해 필요한 태그를 입력하십시오. 다른 레퍼런스에 이미 존재하는 태그가 있다면 그것을 선택할 수
있습니다. 태그는 왼쪽 사이드바의태그태그탭에서 레퍼런스를 필터링하는 데 사용됩니다.태그별 레퍼런스관리를 참조하십시
오.

6. 가능한 많은 필드를 채우십시오.

폴더에 레퍼런스를 바로 추가하려면, 왼쪽 사이드바에서 원하는 폴더를 선택한 후추가추가 > 새로운새로운 레퍼런스레퍼런스 직접직접입력입력을
선택합니다.

Note
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o 자세한 내용은레퍼런스편집을 참조하십시오.
o 사용자 필드를 정의해 놓은 경우 (기본정보 설정참조),더더 많은많은 데이터데이터 항목항목추가추가를 선택하여 해당 필드들을 레퍼런스에
추가한 다음 값을 입력 할 수 있습니다.

o 레퍼런스를 생성하거나 편집하는 동안 사용자 필드를 만들어 추가할 수도 있습니다.더더 많은많은 데이터데이터 항목항목추가추가에서 사
용자 필드 이름을 입력하고 “…” 을을(를를)사용자사용자 필드로필드로추가추가를 선택하십시오.

사용자 필드 추가

사용자 필드가 저장되고 레퍼런스에 추가됩니다. 이제 모든 레퍼런스에서 이 사용자 필드가 사용될 수 있습니다.

새로운 사용자 필드
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7. 완료되면저장저장을 선택하십시오.

파일 업로드를 통해 레퍼런스 추가
RefWorks에에 파일파일 업로드하기업로드하기:

마우스로 파일을 중앙 창으로 끌어다 놓거나 또는추가추가 > 파일파일업로드업로드를 선택한 다음 파일을 선택하십시오. 파일은 어떤 형식
이든 가능합니다.

파일은 Generic(일반일반)유형의 레퍼런스로 업로드 됩니다. RefWorks는 업로드된 파일에서 최대한 많은 정보를 자동으로 추
출하려고 합니다. 레퍼런스 편집을 통해 정보를 수정하고 완료하십시오.

한 번에 여러 파일을 마우스로 끌어다 놓으면 레퍼런스가 각 파일에 대해 생성됩니다.

레퍼런스 반입
다른 서지관리도구에서 레퍼런스를 가져올 수 있습니다. 다른 RefWorks 계정 또는 Mendeley 계정에서 직접 가져올 수 있습
니다. Zotero와 같은 다른 서비스의 경우에는 해당 서비스에서 반출한 파일을 가져올 수 있습니다.레퍼런스파일로내보내기
를 참조하십시오.

다른다른 서지관리도구에서서지관리도구에서 레퍼런스레퍼런스 가져오기가져오기:

1. RefWorks 또는 Mendeley 이외의 다른 서지관리도구로부터 반입하려면 해당 서비스에서 NLM PubMed, RefWorks
Tagged, RefWorks XML, RIS 또는 Thomson Reuters 형식 중 하나로 레퍼런스를 반출합니다. 예를 들면 다음과 같습
니다.
o Zotero: 여러 레퍼런스를 선택하고 마우스 오른쪽 클릭 메뉴에서 Export Selected Items를 선택하십시오. RIS형
식을 선택하고 파일을 저장하십시오.
o EndNote: 1) Edit > Output Styles > Open Style Manager를 선택하고 RefMan (RIS) Export를 선택하십시오. 2)
원하는 레퍼런스를 선택한 후 File > Export를 선택한 다음 파일을 RefMan (RIS) Export로 저장하십시오.
o ReadCube: 하나 또는 여러 건의 원하는 레퍼런스를 선택하고 마우스 오른쪽 클릭 메뉴에서 Export to RefMan
(RIS) file를 선택한 다음 파일을 저장하십시오.
o Papers: 원하는 레퍼런스를 하이라이트 하고 File > Export를 선택한 후 Refman RIS를 선택하고 파일을 저장하십
시오.

2. 추가추가 > 레퍼런스레퍼런스가져오기가져오기를 선택하십시오. 다른 레퍼런스 도구에서 레퍼런스 데이터 가져오기 페이지가 나타납니다.

다른 레퍼런스 도구에서 레퍼런스 데이터 가져오기

3. RefWorks 또는 Mendeley에서 가져오려면 관련 작업을 선택하고승인승인을 선택하십시오. 해당 레퍼런스 도구의 로그인
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페이지가 나타납니다. 레퍼런스 도구에 로그인하십시오.

다른 방법으로는 내보내기 한 레퍼런스 목록이 포함된 파일을 마우스로 끌어다 놓거나,컴퓨터에서컴퓨터에서 파일파일선택선택을 선택
하십시오. 파일을 선택한 후 관련 형식을 선택하고 (RIS 또는 Thomson Reuters 형식의 경우에는 가장 밀접하게 매칭된
데이터베이스 선택),가져오기가져오기를 선택하십시오. 다른 서비스로부터 RefWorks로 레퍼런스가 복사됩니다.

두 경우 모두 내 RefWorks에 레퍼런스가 추가됩니다.

PubMed에서에서 레퍼런스레퍼런스 가져오기가져오기:

1. 다음 중 하나를 수행하십시오.
o 내보내기 할 레퍼런스 선택.
o 어떤 레퍼런스도 선택하지 않으면 모든 레퍼런스가 해당됨.

2. 저장저장을 클릭하십시오.

3. RIS형식을 선택하고파일파일생성생성을 클릭하십시오.

4. 파일을 내 컴퓨터에 저장하십시오.

5. RefWorks에서추가추가 > 레퍼런스레퍼런스가져오기가져오기를 선택하십시오.

6. 내 컴퓨터에서 파일을 선택하거나, 파일을 가져오기 페이지로 마우스로 끌어다 놓습니다.

7. 가져오기가져오기를 클릭하십시오.

내 레퍼런스가 RefWorks 에 추가됩니다.

레퍼런스 관리

레퍼런스 보기
왼쪽 사이드바에서 관련 탭을 선택하면모든 레퍼런스 목록, 공유된 레퍼런스 폴더또는 삭제된 레퍼런스를 볼 수 있습니다
(RefWorks의 사용자 인터페이스참조). 각 레퍼런스에는 고유한 레퍼런스 ID (Ref ID)가 포함되어 있습니다.

레퍼런스 보기 옵션은 다음과 같습니다.

레퍼런스레퍼런스 보기보기 옵션옵션

대상 방법 설명

정
렬
기
준
선
택

전체 모든모든 레퍼런스레퍼런스

가
능
여
부

검색 결 검색 전체 필드에 대해 검색하려면 기본 검색을 이용하고, 특정 필드에 대해 검색하려면 고급 검색을 선택합니
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과

다. 기본 검색에서는 태그 이름 또는 원하는 검색어를 입력합니다. 검색어를 입력하면 검색된 레퍼런스가
중앙 창에 나타납니다.

특정 필드 검색 시, 검색식이 파란색으로 표시됩니다.

필드 검색

기본 검색창에 검색식을 직접 입력할 수 있습니다. 예를 들어, 폴더에는 존재하지 않고 저자명에
"Rowling"과 태그에 " mandatory"가 포함된 레퍼런스를 검색하려면 검색식은 _missing_:collectionIds
(authors:(rowling) reference.tags:(mandatory))가 됩니다. 고급 질의어를 작성하는 방법에 대해서는
RefWorks 레퍼런스 필드 및유형을 참조하십시오.

최근 추
가된 레
퍼런스

최근최근 반입된반입된 레레
퍼런스퍼런스

지난 30 일 동안 추가된 레퍼런스. 레퍼런스를 제거하려면 삭제를 선택하십시오. 추가된 레퍼런스는내내폴폴
더더에서는계속 사용할 수 있습니다 (30일 이전에 폴더에 추가된 경우).

다른 사
람이 나
에게 공
유한 레
퍼런스

공유공유 > [폴더폴더
명명]

다른 사람이 나에게 공유한 레퍼런스.공유된 폴더의 레퍼런스 활용참조. 가
능

폴더
내내 폴더폴더 > [폴폴
더더 이름이름]

특정 폴더 또는 하위 폴더에 있는 레퍼런스. 하위 폴더는 최대 3단계까지 확장할 수 있습니다. 예를 들면,
main > sub1 > sub2 > sub3.

가
능

폴더에
없는 레
퍼런스

내내 폴더폴더 > Not
in Folder 특정 폴더 또는 하위 폴더가 지정되어 있지 않은 레퍼런스. 가

능

태그
태그태그 > [태그태그
이름이름]

태그 검색. 태그를 선택하면 해당 태그와 관련있는 레퍼런스를 검색하기 위해 인코딩된 질의어가 기본 검
색창에 나타납니다. 예를 들면, tags:"mandatory".

사용자
필드에
서 매치
된 레퍼
런스

환경환경설정설정 >
[필드필드이름이름]이이
필드를필드를사용한사용한
레퍼런스레퍼런스확인확인

RefWorks에 추가한 사용자 정의 필드에 값이 있는 레퍼런스. 환경 설정(상단 네비게이션에서설정설정선택)
에서 필드 위에 마우스를 대면 나타나는 링크를 선택하십시오.

삭제된
레퍼런
스

휴지통휴지통
다른 탭과 폴더에서 삭제된 레퍼런스.실행실행취소취소를 이용하여 레퍼런스를 복원할 수 있습니다. 일부 레퍼런
스를 영구적으로 제거하려면 휴지통에서 원하는 레퍼런스를 선택하고삭제삭제 > 선택선택 항목항목삭제삭제를 선택한 후
확인 창에서예예를 선택하십시오. 모든 레퍼런스를 제거하려면삭제삭제 > 휴지통휴지통비우기비우기를 선택하십시오.

가
능

특정 페이지에서 보여지는 레퍼런스의 수는 페이지의 상단에 표시됩니다. 상단에 있는 메뉴를 통해 페이지 당 레퍼런스 건수
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변경, 목록 형식, 정렬 기준을 전환할 수 있습니다.

• 간략정보간략정보 – 간략정보 보기. 각 레퍼런스에 대한 폴더와 태그가 표시되며, 원문이 이용 가능한 경우 아이콘이 함께 표시됩
니다. 특정 레퍼런스를 선택하면 (체크박스가 아닌) 오른쪽 사이드바에 레퍼런스의 상세 정보가 나타납니다.

간략정보 목록형식

• 상세정보상세정보 – 상세정보 보기. 원하는 태그를 선택하면 그 태그와 관련된 모든 레퍼런스가 페이지에 새로 표시됩니다. 원문
이 이용 가능한 경우, 첨부 파일 링크를 클릭하면 원문을 볼 수 있습니다. 특정 필드를 선택하면 해당 필드를 편집할 수
있는 레퍼런스 편집창이 오른쪽 사이드바로 나타납니다.

상세정보 목록형식

• 참고문헌참고문헌 양식양식 – 참고문헌 양식으로 보기. 레퍼런스는 설정된 출력 스타일로 표시되며, 다른 출력스타일로 변경하려면
목록형식 메뉴에서 톱니 바퀴 아이콘

을 선택하십시오.

RefWorks는 선택한 출력스타일의 필수 필드 또는 권장 필드가 누락되면 그 곳에 하이라이트 표시를 합니다. 특정 하이
라이트를 선택하면 해당 하이라이트 필드를 편집할 수 있는 레퍼런스 편집창이 오른쪽 사이드바로 나타납니다.
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참고문헌 양식

• 테이블테이블 보기보기 – 또 다른 간략정보 보기. 레퍼런스를 쉽게 정렬할 수 있도록 테이블(표) 양식으로 보여줍니다. 참고로, 이
보기 양식으로 표시되는 레퍼런스는 2,000 개로 제한됩니다. 한 테이블에서 2,000 개 이상의 레퍼런스를 보려면 레퍼런
스 내보내기를 한 다음 Microsoft Excel과 같은 스프레드 시트 프로그램을 이용합니다.

테이블 보기

RefWorks 내에서내에서 원문보기원문보기

부분 또는 전체 원문에 대해 온라인 접근이 가능한 레퍼런스일 경우, 오른쪽 사이드바에서 원문에 접근할 수 있습니다. 도서
관 또는 외부 사이트에서 제공하는 텍스트나 업로드 된 파일에 접근할 수 있습니다.

한 페이지에서 많은 수의 레퍼런스를 확인하고자 할 경우, 특히 상세정보 목록형식 사용 시, RefWorks가 레퍼런스 목록
을 표시하는 데 시간이 걸릴 수 있습니다.

Note
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오른쪽 사이드바

레퍼런스 목록형식을 상세정보 보기로 볼 때, 원문을 보려면 링크(이용 가능한 경우)를 클릭하십시오.

상세정보 목록형식: URL 또는 업로드된 파일 링크

업로드된 파일과 같이 일부 레퍼런스의 경우, 레퍼런스의 상세정보가 직접 제공됩니다. RefWorks Reader를 사용하면 문서
를 다운로드하고, 텍스트 구절에 하이라이트 및 메모를 표시하는 등 주석을 달수 있습니다.
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폴더별 레퍼런스 관리
폴더폴더 관리하기관리하기:

여러 레퍼런스를 선택하고폴더에폴더에지정지정을 선택하십시오. 선택한 레퍼런스를 기존 또는 새 폴더에 지정하거나, 해당 폴더에서
레퍼런스를 제거할 수 있습니다.

폴더는 왼쪽 사이드바의내내 폴더폴더탭에 있습니다. 폴더 내의 레퍼런스 수는 각 폴더 이름 뒤에 표시됩니다.

내내 폴더폴더탭을 열어, 레퍼런스를 원하는 폴더 위에 마우스로 끌어다 놓는 방법으로 저장할 수 있습니다. 또한내내폴더폴더에서 하위
폴더 추가 또는 폴더 이름 변경, 폴더 공유, 삭제할 수 있습니다. 하위 폴더는 최대 3 단계까지 가능합니다. 예시 : main >
sub1 > sub2 > sub3. 이러한 작업은 특정 폴더의 작업 메뉴에서 사용할 수 있습니다.

폴더 작업 메뉴

태그별 레퍼런스 관리
태그태그 관리하기관리하기:

여러 레퍼런스를 선택하고태그태그추가추가를 선택하십시오. 선택한 레퍼런스에 기존 또는 새 태그를 추가하거나 태그를 제거할 수
있습니다.

왼쪽 사이드바에서태그태그탭을 열어, 레퍼런스를 마우스로 원하는 태그 위로 끌어다 놓으면 레퍼런스에 해당 태그를 추가할
수 있습니다.

오른쪽 사이드바에서 레퍼런스를 편집할 때 태그를 관리할 수 있습니다.

레퍼런스 편집
• 단일단일 레퍼런스레퍼런스 - 간략정보간략정보 목록형식목록형식:중앙 창에서 레퍼런스를 선택하면 레퍼런스의 세부 정보를 오른쪽 사이드바에서 확
인할 수 있습니다. 상단의 편집 아이콘

을 선택하여 레퍼런스를 편집한 후저장저장을 선택하십시오. 사용자 정의 필드(기본정보 설정참조)에 대해서도 해당 필드
를 추가하거나 편집할 수 있습니다. 자세한 내용은새로운레퍼런스직접 입력하기참조하십시오.

기관에서 설정한 경우, RefWorks의 링크리졸버를 통해 소속 기관 도서관의 자료를 검색하여 레퍼런스에 원문을 추가할
수 있습니다. RefWorks에 추가할 레퍼런스를 찾았다면 해당 페이지에서내보내기내보내기 > RefWorks로 저장하거나, 레퍼런스
를 다운로드한 후 RefWorks로 업로드하십시오. RefWorks에서 도서관 원문(Full-text) 자료를 추가하려면 레퍼런스의 오
른쪽 사이드바에서 링크리졸버(Find it @Library 등)를 사용하여원문원문검색검색을 선택하십시오(기관마다 링크리졸버 이름이
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다를 수 있음).

• 단일단일 레퍼런스레퍼런스 - 상세정보상세정보 또는또는 참고문헌참고문헌 양식양식 목록형식목록형식:레퍼런스 내 필드를 선택하면 오른쪽 사이드바가 바로 편집 모
드로 열립니다(편집 아이콘을 선택할 필요는 없습니다).

rich-text edit bar는 특정 텍스트 필드(제목, 대체 제목, 초록, 메모 및 RefWorks에 추가한 사용자 정의 필드 포함) 내에서 단어
를 선택할 때 사용할 수 있습니다.

Rich Text Edit Bar

• 레퍼런스레퍼런스 대량대량 편집편집:

1. 여러 레퍼런스를 선택한 다음도구도구 > 대량대량편집편집을 선택하면 대량 편집 페이지가 나타납니다.

대량 편집

2. 필요 시, 편집 대상을 1 단계에서 선택한 레퍼런스만으로 할지 모든 레퍼런스를 대상으로 할지를 선택하십시오.

3. 필드를 추가할지삭제할지, 또는 내용의 일부를 변경할지를 선택하십시오.

◦ 추가: 추가 선택 시,선택한선택한 필드에필드에 추가추가또는전자정보전자정보 필드에필드에 추가추가가능
▪ 선택한 필드에 추가: 원하는 필드를 선택한 후 값을 입력하고, 필드에 데이터가 이미 포함되어 있는 경우 어떻
게 처리할지(기존 데이터는 그대로 두기, 기존 데이터 덮어쓰기, 기존 데이터에 추가) 선택하십시오. 날짜 필드
는 기존 데이터에 추가할 수 없습니다.

▪ 전자정보 필드에 추가: 자료 출처,원본원본 DB, URL, 검색검색 일자일자필드에 값을 입력하십시오. 필드에 데이터가 이미
포함되어 있을 경우 어떻게 처리할지(기존 데이터는 그대로 두기, 기존 데이터 덮어쓰기, 기존 데이터에 추가)
선택하십시오. 날짜 필드는 기존 데이터에 추가할 수 없습니다.데이터데이터추가추가를 선택하고 확인 대화 창에서 예
를 선택하십시오.

◦ 삭제:삭제삭제를 선택하고, 원하는 필드를 선택하십시오.데이터데이터삭제삭제를 선택하고, 확인 대화 창에서예예를 선택합니다.

◦ 바꾸기:바꾸기바꾸기를 선택하고, 원하는 필드를 선택하십시오. 바꿀 문자열을 입력하십시오. 변경하고자 하는 문자열
을 입력할 때, 부분 일치 또는 전체 단어 일치 여부를 선택할 수 있습니다. 변경하고자 하는 문자열을 입력한 후,데데
이터이터변경변경을 선택하고, 확인 대화 창에서예예를 선택하십시오. 참고로, 두 문자열 중 어느 하나의 문자열에만 정규
문법을 사용할 수 없다는 점에 유의하십시오. 단순한 텍스트 문자열만 가능합니다. 선택한 필드에서 일치하는 문
자열의 모든 문자열이 새 문자열로 바뀝니다.
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중복 레퍼런스 삭제
레퍼런스 수가 너무 많거나, 여러 출처에서 레퍼런스를 대량으로 추가했거나, 단순히 기억을 못할 경우, RefWorks가 컬렉션
에서 중복을 찾아서 제거해 주는 것이 도움이 될 수 있습니다.

중복중복 레퍼런스레퍼런스 제거하기제거하기:

1. 도구도구 > 중복중복찾기찾기를 선택하십시오.

또는 내 폴더 탭의 폴더 작업 메뉴에서중복중복찾기찾기를 선택하십시오.

중복 레퍼런스 찾기 대화 창이 나타납니다.

중복 레퍼런스 찾기

2. 폴더를 보거나 검색 결과 (및 태그)를 보는 동안 이 작업을 선택한 경우, 레퍼런스 전체를 대상으로 할지 아니면 현재 위
치 내에서만 중복 검사할지 선택할 수 있습니다.

3. 각 옵션 아래 세부 사항에 따라 검사 기준을 선택하십시오.

4. 중복중복찾기찾기를 클릭하십시오. 중복이 발견되면 그 부분이 하이라이트로 사전 선택이 되어 있어 삭제가 용이합니다.

• 중복 제거 기능은 공유 프로젝트에서는 사용할 수 있지만 공유 폴더에서는 사용할 수 없습니다.

• RefWorks는 최대 2,000 개의 레퍼런스에 대해 중복을 비교하고 찾을 수 있습니다.

Note
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중복 레퍼런스

삭제된 레퍼런스 복구
휴지통휴지통탭 이외의 다른 폴더나 탭에서 삭제된 레퍼런스는 복원이 가능합니다. 레퍼런스를 복원하려면휴지통휴지통탭으로 이동하
여 복원할 레퍼런스를 선택한 후실행실행취소취소를 선택하십시오.

삭제된 레퍼런스 복구

RefWorks에 저장된 레퍼런스를 문서에 활용
Microsoft Word 또는 Google Docs와 같은 문서에서 레퍼런스를 인용할 때, RefWorks를 사용하여 레퍼런스를 원하는 포맷으
로 문서에 쉽게 삽입할 수 있습니다. 하나 또는 여러 레퍼런스를 삽입할 수 있으며, 본문 내 인용문헌 또는 참고문헌리스트로
또는 둘 다 삽입할 수 있습니다. 기본 출력스타일(RefWorks 또는 CSL 스타일)을 선택하거나 자신만의 스타일을 만들 수 있
습니다.

스타일을 관리하려면출력스타일관리를 참조하십시오.

RefWorks에서 레퍼런스를 작성하여 문서에 복사하는 방법도 쉽지만, RefWorks 플러그인을 사용하여 문서에서 작업하면서
레퍼런스를 추가하는 방법이 보다 용이합니다. 또한 여러 플러그인(삭제, 다시 추가, 스타일 변경 등) 중 하나를 사용하여 문
서에서 레퍼런스를 관리할 수 있습니다.

• Microsoft Word에서 작업하면서 문서에 레퍼런스를 추가하고 관리하려면, Write-n-Cite또는 RCM(RefWorks Citation
Manager)을 사용하십시오. Write-n-Cite 활용활용및 RCM활용활용을 참조하십시오.

• Google Docs에서 같은 방식으로 작업을 하려면, Google Docs RefWorks를 사용하십시오.

참고문헌참고문헌 리스트리스트 만들기만들기:

1. 레퍼런스 목록을 보면서 원하는 레퍼런스를 선택하고 (또는 모든 레퍼런스를 사용하기 위해 아무 것도 선택하지 않음)
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참고문헌참고문헌 생성생성 > 참고문헌참고문헌 리스트리스트만들기만들기를 선택하십시오. 참고문헌 결과 페이지가 나타납니다.

참고문헌 리스트 만들기

2. 필요시 다른 출력스타일을 선택하십시오. 기본적으로 참고문헌은 RefWorks에서 마지막으로 사용했던 스타일로 출력
됩니다.

3. 클립클립 보드에보드에복사복사를 선택한 다음 문서에 붙여 넣습니다.

한한 개개 또는또는 복수의복수의 본문본문 내내 인용문헌인용문헌 삽입하기삽입하기 (참고문헌참고문헌 리스트리스트 포함포함 / 배제배제)

1. 레퍼런스 목록을 보면서참고문헌참고문헌 생성생성 > 인용인용&참고문헌참고문헌 리스트리스트 간편하게간편하게만들기만들기를 선택하십시오. 대화 상자가 나타
납니다.
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Quick Cite의 출력스타일 탭

2. 원하는 출력 스타일을 선택하고계속계속…을 선택하십시오.
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Quick Cite의 인용문헌 선택 탭

3. 레퍼런스 하나를 삽입하려면 레퍼런스 위에 마우스를 놓고인용인용복사복사를 선택하십시오. 레퍼런스 여러 개를 하나의 인용문
헌으로 삽입하려면 복수의 레퍼런스를 선택하고 클립 보드에 복사 아이콘을 선택하십시오. 그리고 문서에 붙여 넣습니다.

4. 참고문헌을 삽입하려면 체크박스 또는 별 아이콘을 사용하여 관련 레퍼런스를 선택하고참고문헌으로참고문헌으로계속계속을 선택하십
시오.

숫자로 표기되는 출력스타일을 사용하기 원한다면 Word 또는 Google Docs 내에서 인용 및 참고문헌을 작성하는 방식
을 강력하게 추천합니다. 인용&참고문헌 리스트 간편하게 만들기 기능을 사용하면 문서에서 숫자를 입력하거나 수동으
로 수정해야 합니다.

Note

Ex Libris, Part of Clarivate 16



Quick Cite의 참고문헌 탭

5.클립보드에클립보드에복사복사를 선택한 후 문서에 붙여 넣습니다.

레퍼런스 공유 및 공유된 레퍼런스 활용
특정 이용자 또는 기관의 모든 이용자(기관에서 활성화한 경우)와 내 레퍼런스 폴더를 공유할 수 있고, 나에게 또는 우리 기
관에게 공유된 레퍼런스 폴더를 볼 수 있습니다. 공유된 레퍼런스는 경우에 따라 주석을 추가하거나 레퍼런스를 변경할 수
있습니다. 나에게 공유된 레퍼런스를 편집하거나 내보내기 하려면 먼저 해당 레퍼런스를 자신의 폴더로 복사해야합니다.

레퍼런스 폴더 공유
1. 공유공유 > 폴더폴더공유공유를 선택하십시오.
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또는 왼쪽 사이드바의레퍼런스레퍼런스 공유공유탭에서폴더폴더공유공유를 선택하십시오.

또는내내 폴더폴더탭의 작업 메뉴에서폴더폴더공유공유를 선택하십시오.

공유 환경설정 대화 창이 나타납니다.

공유 환경설정

2. 공유공유대상대상에서 공유할 폴더를 선택하십시오.

3. 공유공유대상대상에서 공유할 폴더를공유할공유할이용자이용자에서 이메일 주소를 입력한 이용자와만 공유할 것인지 또는 기관의 모든
이용자와 공유할 것인지 선택합니다. 이 부분은 나중에 변경할 수 있습니다.

4. 공용공용 URL에서공용공용 URL작성작성을 선택하여 RefWorks 계정이 없는 다른 사용자와 폴더 및 하위 폴더의 레퍼런스를 공유
하는 데 사용할 수 있는 URL을 생성하십시오.

5. 공용 URL을 통한 폴더에 대한 공개 액세스를 제거하려면 URL제거제거를 선택하십시오.

6. 공유할공유할이용자이용자에서, 폴더를공유할 대상의 이메일 주소를 입력하십시오. 각 이메일 주소에 대해 공유 레퍼런스 이용 권
한을 선택하십시오.

◦ 레퍼런스 열람 권한 – 레퍼런스 열람만 가능
◦ 레퍼런스 주석달기 권한 – 메모를 읽거나 추가할 수 있으며, 레퍼런스에 하이라이트 표시 가능
◦ 레퍼런스 수정 권한 – 레퍼런스 추가 및 삭제, 첨부된 지원 가능한 PDF 파일을 읽거나, 레퍼런스에 주석 달기 가능

필요 시, 이용자에게 초대 메시지를 추가할 수 있습니다. 해당 이용자는 초대를 알리는 이메일을 받습니다.

내 폴더가 누구와 공유되어 있는지 관련 사용자를 볼 수 있고그들의 공유 옵션을 변경하거나 제거할 수 있습니다.

7. 설정이 완료되면완료완료를 선택하십시오.

언제든지 폴더의 공유를 해제하려면 공유 환경설정 대화 창에서폴더폴더 공유공유해제해제를 선택한 후 확인 대화 창에서예예를 선택십
시오.
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공유된 폴더의 레퍼런스 활용
어떤 폴더가 나에게 공유될 때 이를 알리는 이메일을 받습니다. RefWorks의 레퍼런스 공유 탭에서 해당 폴더를 볼 수 있습니
다. 단일 기관으로부터 나에게 공유된 모든 폴더가 함께 그룹되어 있습니다.

Ex Libris 대학교에서 공유된 모든 폴더

공유 폴더에 있는 레퍼런스를 보려면 초대를 수락해야 합니다. 폴더 행에서가입가입을 선택하십시오.

Ex Libris 대학교에서 공유된 폴더

폴더는 왼쪽 사이드바의레퍼런스레퍼런스 공유공유탭에 나타납니다. 이 폴더 내 레퍼런스에 대한 모든 태그가 현재 태그 목록에 추가됩
니다.

• 공유 폴더에 있는 레퍼런스와 주석을 볼 수 있습니다. 폴더를 공유해준 사용자가 권한을 부여해주면 참고문헌에 주석을
추가할 수 있으며, 나아가 레퍼런스를 추가하거나 삭제할 수 있습니다.

• 이러한 공유 레퍼런스를 반출하거나 Dropbox와 동기화 하려면 (기관에서 활성화한 경우,관리 설정참조), 해당 레퍼런
스를 내 레퍼런스 목록에 복사해야 합니다. 이를 위해 레퍼런스를 폴더로 끌어다 놓거나폴더에폴더에지정지정을 선택하십시오.
또한공유공유 > 공유된공유된 폴더에서폴더에서 레퍼런스레퍼런스복사복사를 선택하여 레퍼런스를 모든 레퍼런스에 복사할 수 있습니다.

• 폴더 탭의 작업 메뉴를 사용하여 공유 폴더에 대한 접근 권한을 제거할 수 있습니다. 공유 폴더에 대한 자신의 접근 권한
을 제거하면, 해당 폴더 내의 레퍼런스와 연관되어 있는 모든 태그가 내 태그 목록에서 제거됩니다.

레퍼런스를 파일로 반출하기
내 레퍼런스를 반출할 수 있으며, 이는 다른 사용자가 내 계정으로 로그인 하지 않고 그것을 반입할 수 있도록 해주거나, 다른
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서지 관리 도구로 반입할 수 있도록 해줍니다.레퍼런스반입도 참고하십시오.

레퍼런스레퍼런스 반출하기반출하기

1. 반출하려는 특정 폴더나,모든모든 레퍼런스레퍼런스또는 검색 결과로부터공유공유 > 레퍼런스레퍼런스내보내기내보내기를 선택하십시오.

레퍼런스 내보내기

2. 현재 폴더 / 검색 결과 내에 있는 모든 레퍼런스를 내보낼 지 아니면 선택한 레퍼런스만 내보낼 지를 선택합니다.

3. 출력 형식(BibTeX, RIS, 탭으로 구분된 텍스트, 또는 XML)을 선택하십시오.

4. 내보내기내보내기를 선택하십시오. 레퍼런스가 반출되며, 필드 이름이 포함됩니다. 탭으로 구분된 텍스트 파일에는 첫 번째 행
에 필드 이름이 들어 갑니다.

프로젝트 기능

프로젝트 관리
RefWorks에서 프로젝트를 만들 수 있습니다. 프로젝트를 사용하면 각기 다른 연구 프로젝트에 대해 별도의 레퍼런스 컬렉션
을 관리할 수 있습니다.

프로젝트프로젝트 관리하기관리하기:

1. 상단 네비게이션에서 내 프로젝트 이름 옆에 있는 화살표를 선택하고 프로젝트 관리를 선택하십시오.

프로젝트 관리

Ex Libris, Part of Clarivate 20



내 프로젝트 페이지가 나타납니다.

내 프로젝트

2. 새 프로젝트를 만들려면새새 프로젝트프로젝트작성작성을선택하십시오. 아래 화면이 나타납니다.

3. 프로젝트 이름을 입력하고저장저장을 선택합니다. 해당 프로젝트가 프로젝트 목록에 추가됩니다. 페이지 상단의 프로젝트
메뉴에서 프로젝트를 탐색할 수 있습니다.

4. 프로젝트 이름을 변경하거나 삭제하려면작업작업 > 이름이름 바꾸기바꾸기또는작업작업 >삭제삭제를 선택하십시오.

한한 프로젝트에서프로젝트에서 다른다른 프로젝트로프로젝트로 레퍼런스레퍼런스 이동하기이동하기:

• 레퍼런스 내보내기 기능 이용하기:
a.공유공유 > 레퍼런스레퍼런스내보내기내보내기를 선택하여 프로젝트에서 레퍼런스를 반출하십시오.
b.레퍼런스를 반입할 프로젝트로 이동하십시오.
c.추가추가 >가져오기가져오기를 선택하여 레퍼런스를 반입하십시오.

• 공유 폴더 이용하기 (대량의 레퍼런스를 이동할 때는 보다 빠른 방법이 될 수 있음):
a.레퍼런스를 반출하려는 프로젝트에서 새 폴더를 생성하십시오 (내내 폴더폴더 > 폴더폴더 추가추가).
b.이동할 레퍼런스를 선택한 다음 새 폴더로 옮깁니다.
c.내 폴더에서 폴더를 선택한 다음 폴더 작업 메뉴에서폴더폴더공유공유를 선택하십시오. 공유 환경설정 창이 열립니다.
d.기관기관 내내 이용자들에게이용자들에게 이이 폴더의폴더의 접근을접근을허용합니다허용합니다를 선택한 다음완료완료를 선택하십시오.
e.프로젝트 메뉴에서 레퍼런스를 반입하려는 프로젝트를 선택하십시오.
f.공유 폴더에 가입하십시오 (레퍼런스레퍼런스 공유공유 > 내내 기관에기관에 있는있는 폴더폴더 > 가입가입).
g.공유 폴더에 있는 레퍼런스를 프로젝트 폴더로 옮깁니다.
h.폴더 공유를 종료하십시오. (레퍼런스레퍼런스 공유공유 > [공유공유 폴더폴더 이름이름] > 폴더공유폴더공유 종료종료).
i.프로젝트 메뉴에서 원래 프로젝트를 선택합니다.
j.폴더 공유를 중지하고 (레퍼런스레퍼런스 공유공유 > [공유공유 폴더폴더 이름이름] > 지정한지정한 이용자에게만이용자에게만 폴더폴더 접근을접근을 허용합니다허용합니다)완료완료를 선
택하십시오.

프로젝트를프로젝트를 현재현재 프로젝트로프로젝트로 설정하기설정하기:
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• 프로젝트 관리 페이지에서작업작업 > 현재현재 프로젝트로프로젝트로 설정설정(Set as Current Project)을 선택하십시오.

• 프로젝트 이름을 선택하십시오. 해당 프로젝트가 현재 프로젝트로 설정되고 해당 페이지가 열립니다.

프로젝트에서 사용할 수 있는 부가적인 기능은 다음과 같습니다:

• Write-n-Cite 및 Google Docs 플러그인은 현재 프로젝트의 레퍼런스를 사용합니다. 프로젝트를 변경하려면 RefWorks에
서관련 프로젝트로 이동하십시오.

• 데이터베이스에서 RefWorks로로 내보내기내보내기기능기능을 사용할 때, RefWorks Citation Manager (RCM)을 사용할 때 사용할
프로젝트를 선택할 수 있습니다.

RefWorks로 내보내기

프로젝트 공유
RefWorks의 다른 사용자와 프로젝트를 공유할 수 있습니다. 프로젝트가 공유되면 폴더 및 레퍼런스의 추가, 삭제 및 수정을
포함한 프로젝트 내 모든 권한이 그들에게 부여됩니다. 프로젝트의 모든 공유 소유자가 프로젝트를 삭제할 수 있습니다.

프로젝트를 공유하면 RefWorks Citation Manager (RCM)를 사용할 때 프로젝트의 다른 소유자와 공동으로 작업할 수 있습니
다. 공유 프로젝트의 레퍼런스가 인용된 문서는 각 소유자에 의해 제공될 수 있고, 소유자 간 이메일로 발송할 수 있습니다.
각 협업자들은 개별적으로 문서를 작업한 다음 추가 작업을 위해 다른 소유자에게 이메일을 보냅니다. 여러 사용자가 동시에
문서를 편집하지는 않습니다.

다음 메뉴에서이이 프로젝트프로젝트공유공유를 선택하여 프로젝트를 공유합니다.

• 프로젝트 메뉴:

문서에서는 하나의 프로젝트의 레퍼런스로만 사용할 수 있습니다.

Note

한 프로젝트 내에서 레퍼런스 ID는 고유합니다. 따라서 공유 프로젝트에 레퍼런스를 추가할 때 Ref ID가 부여되지만, 내
가 생성한 레퍼런스의 마지막 Ref ID와 연속적인 번호를 받는 것은 아닙니다.

Note
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프로젝트 메뉴에서 프로젝트 공유

• 내 프로젝트 페이지의 프로젝트작업작업메뉴 (프로젝트 메뉴 > 프로젝트 관리):

작업 메뉴 내 프로젝트 공유

프로젝트 공유 설정창이 나타나고 프로젝트를 공유한 사람이 표시됩니다.

프로젝트 공유 설정

이 페이지에서 사용 가능한 작업은 다음과 같습니다.

• 프로젝트를 다른 이용자와 공유하려면,다른다른 사용자사용자 초대초대필드필드에 이메일 주소를 입력하고완료완료를 클릭하십시오.

• 특정 이용자와 프로젝트 공유를 해제하려면 멤버의 이메일 주소 옆에 있는제거제거를 클릭하고완료완료를 클릭하십시오.

• 모든 이용자와 프로젝트 공유를 해제하려면프로젝트프로젝트 공유공유해제해제를 클릭하십시오.

Article last edited: 07-07-2020
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